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PREFACE 
 
This document assumes that the reader is generally familiar with using computer hardware and 
software. Describing a feature that is usually easily understood has been avoided wherever 
possible.  
 

Introduction 
 
TrueCrypt is a software system for establishing and maintaining an on-the-fly-encrypted volume 
(data storage device). On-the-fly encryption means that data are automatically encrypted or 
decrypted right before they are loaded or saved, without any user intervention. No data stored on 
an encrypted volume can be read without using the correct password or encryption key. Until 
decrypted, a TrueCrypt volume appears to be nothing more than a series of random numbers. 
Entire file system is encrypted (i.e., file names, folder names, contents of every file, and free 
space). TrueCrypt never writes decrypted data to any storage device (it only temporarily writes 
data being decrypted to RAM). 
 

TrueCrypt Volume 
 
There are two types of TrueCrypt volumes:  

• Container 
• Partition/device 

 
A TrueCrypt container is a normal file, which can reside on any type of storage device. It contains 
(hosts) a completely independent encrypted virtual disk device. Container is a file-hosted volume. 
 
A TrueCrypt partition is a hard disk partition encrypted using TrueCrypt. You can also encrypt 
floppy disks, ZIP disks, USB hard disks, USB memory sticks, and other types of storage devices. 
 

Creating a New TrueCrypt Volume 
 
To create a new TrueCrypt file-hosted container or to encrypt a partition/device (requires 
administrator privileges), click on ‘Create Volume’ in the main program window. TrueCrypt Volume 
Creation Wizard should appear. As soon as the Wizard appears, it starts collecting data that will be 
used in generating the master key, the salt, and the values used to create IV (initialisation vector) 
and whitening values for the new volume. The collected data, which should be as random as 
possible, include your mouse movements, mouse clicks, key presses, and other values obtained 
from the system (for more information, please see Random Number Generator). The Wizard 
provides help and information necessary to successfully create a new TrueCrypt volume. However, 
several items deserve further explanation: 
 

Hash Algorithm 

Allows you to select which hash algorithm TrueCrypt will use. The selected hash algorithm is used 
by the random number generator (which generates the master key, salt, and the values used to 
create IV and whitening values). It is also used in deriving the new volume header key.  



 

TrueCrypt User’s Guide. Copyright © 2004-2005 TrueCrypt Foundation. All rights reserved. 
 

5 

TrueCrypt currently supports two hash algorithms: RIPEMD-160, which was designed by an open 
academic community, and SHA-1 designed by the NSA and NIST. 

Note that the output of a hash function is never used directly as an encryption key. Please refer to 
the section Technical Details for more information. 
 

Encryption Algorithm 

This allows you to select the encryption algorithm with which your new volume will be encrypted. 
For more information, please see the section Encryption Algorithms. 
 

Quick Format 
 
If unchecked, each sector of the new volume will be formatted. This means that the new volume 
will be entirely filled with random data. Quick format is much faster but may be less secure 
because until the whole volume has been filled with files, it may be possible to tell how much data 
it contains (if the space was not filled with random data beforehand). If you are not sure whether to 
enable or disable Quick Format, we recommend that you leave this option unchecked. Note that 
Quick Format can only be enabled when encrypting partitions/devices.  
Important: When encrypting a partition/device within which you intend to create a hidden volume 
afterwards, leave this option unchecked. 
  

Cluster Size 
 
Cluster is an allocation unit. For example, for a one-byte file, at least one cluster is allocated on 
FAT file system. When the file grows beyond the cluster boundary, another cluster is allocated. 
Theoretically, this means that the bigger the cluster size, the more disk space is wasted; however, 
the performance is better. If you do not know which value to use, leave the setting at default. 
 

Auto-Test All Algorithms 
 
The built-in automatic self-test facility, accessible from the Encryption Options page of the Volume 
Creation Wizard, automatically tests all the encryption algorithms and all the hash algorithms 
(HMAC’s) implemented in TrueCrypt and reports the results. These tests are also run each time 
right before you start the Volume Creation Wizard. If there is any error, it is reported and the wizard 
will not start (this will prevent you from creating new volumes when the program is corrupted).  
 

TrueCrypt Volume on CD, DVD, and Other Read-Only Media 
 
If you want a TrueCrypt volume to be stored on a CD, DVD, or other read-only media, first create a 
file-hosted TrueCrypt container on a hard drive and then burn it onto a CD/DVD using any CD/DVD 
burning software (or, under Windows XP, using the built-in system tool). Remember that if you 
need to mount a TrueCrypt volume that is stored on a read-only medium (such as a CD/DVD) 
under Windows 2000, you must format the TrueCrypt volume as FAT (Windows 2000 cannot 
mount NTFS file system on read-only media).  
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Hardware/Software RAID, Windows Dynamic Volumes 
 
TrueCrypt supports hardware/software RAID as well as Windows dynamic volumes. If you intend 
to format a dynamic volume as a TrueCrypt volume, keep in mind that after you create the dynamic 
volume (using the Windows Disk Management tool), you must restart the operating system in order 
for the volume to be available/displayed in the ‘Select Device’ window of the TrueCrypt Volume 
Creation Wizard.  
 
Also note that, in the ‘Select Device’ window, a dynamic volume is not displayed as a single device 
(one item). Instead, all the volumes that the dynamic volume consists of are displayed and you can 
select any of them in order to format the entire dynamic disk. 
 

Additional Notes on Volume Creation 
 
After you click the 'Format' button in the Volume Creation Wizard window (the last step), there will 
be a short delay while your system is being polled for additional random data. Afterwards, the 
master key, header key, salt, and the values used to create the IV and whitening values for the 
new volume will be generated, and the master key and header key contents will be displayed.  
 
For increased security, the randomness pool, master key, and header key contents can be 
prevented from being displayed by unchecking the checkbox in the upper right corner of the 
corresponding field: 
 
 

 

Fig. 1. Randomness pool, master key, and header key contents displayed by the Volume Creation Wizard. 

 
 
Note that only the first 112 bits of the pool/keys are displayed (not the entire contents). 
 
 
Warning: When encrypting entire hard drive partition/device, i.e., formatting it as a TrueCrypt 
volume, all data stored on the partition/device will be lost! 
    
Important: Several users reported that data on their TrueCrypt volumes were becoming 
corrupted. Later, these users found out that it was not a problem with TrueCrypt but with 
their hardware (chipset, USB PCI card, etc.) Therefore, we recommend that you make sure 
data written to the unencrypted device (where you intend to create a TrueCrypt volume) is 
not becoming corrupted. For example, by copying a large set of files (at least 5 GB in total) 
and then comparing the original files with the copies. 
 
You can create FAT (FAT12, FAT16, FAT32) or NTFS volumes (however, NTFS volumes can only 
be created by users with administrator privileges). TrueCrypt volumes can be reformatted as 
FAT12, FAT16, FAT32, or NTFS anytime. They behave as standard disk devices so you can right-
click the device icon and select 'Format'.  
 
For more information about creating TrueCrypt volumes, see also the section Hidden Volume. 
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Plausible Deniability 
 
In case an adversary forces you to reveal the password, TrueCrypt provides two levels of plausible 
deniability. It is impossible to identify a TrueCrypt container or partition. Until decrypted, a 
TrueCrypt volume appears to consist of nothing more than random data (it does not contain any 
"signature"). Therefore, it is impossible to prove that a file, a partition or a device is a TrueCrypt 
volume and/or that it has been encrypted. The second level of plausible deniability is provided by 
the hidden volume feature (for more information, see the section Hidden Volume).  
 
TrueCrypt container files do not have to have a standard file extension. They can have any file 
extension you like (for example, .raw, .dat, .iso, .img, .rnd, .tc) or they can have no file extension at 
all. TrueCrypt ignores file extensions. If you need plausible deniability, make sure your TrueCrypt 
volumes do not have the .tc file extension (this file extension is ‘officially’ associated with 
TrueCrypt). 
 
When formatting a hard disk partition as a TrueCrypt volume, the partition table (including the 
partition type) is never modified. If you intend to use a TrueCrypt partition and you need plausible 
deniability, follow these steps (applies to Windows XP): 
 

1) Make sure the device can be partitioned.  
Note that some removable media, such as USB memory sticks, cannot be partitioned this way. Instead of 
following these steps, encrypt such device entirely (select it in the Select Device dialog and then proceed as 
usual). 

2) Make sure you have administrator privileges 
3) Right-click the My Computer icon on your desktop or in the Start Menu and select Manage. 
4) In the list (on the left) click Disk Management (within the Storage sub-tree). 
5) If the partition that you want to format as a TrueCrypt volume has already been created, 

right-click it and select Delete Partition…  If the partition has not yet been created, continue 
with step 4) 

6) Right-click the free space (should be labeled as Unallocated) and select New Partition… 
7) New Partition Wizard should appear now. Follow its instructions. On the Wizard page called 

‘Assign Drive Letter or Path’ select ‘Do not assign a drive letter or drive path’. Click Next. 
8) Select Do not format this partition and click Next. 
9) Click Finish. 
10) The partition now appears to be “reserved” for future use (and future reformatting). As it is 

unformatted, it can contain any random data, which might, for example, have resided on the 
hard drive since the last time you repartitioned the hard disk. Therefore, there is no 
difference between such an unformatted partition and a TrueCrypt volume. Now you can 
format the partition as TrueCrypt (to do that, click Create Volume in the main program 
window and follow the Volume Creation Wizard’s instructions). 
 
Note: If, instead of an unformatted partition, you format an NTFS or FAT partition as 
TrueCrypt, such partition will then appear to be a corrupted NTFS or FAT partition. Such 
partition is more likely to be suspected to have been encrypted than an unformatted 
partition (described above). 
 

The timestamp of a file-hosted container (date and time that the container was last accessed, and 
last modified) is never updated* when TrueCrypt accesses the container (i.e., after dismounting, 
attempting to mount, changing or attempting to change the password, or creating a hidden volume 
within it). 
                                                 
* Note that if you use the Windows File Properties tool to view a container timestamp, you will alter the date and time that 
the container was last accessed. 
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Hidden Volume 
 
It may happen that you are forced by somebody to reveal the password to an encrypted volume. 
There are many situations where you cannot refuse to reveal the password (for example, when the 
adversary uses violence). Using a so-called hidden volume allows you to solve such situations in a 
diplomatic manner without revealing the password to your volume.  
 
 
 

 

Fig. 2. The layout of a standard TrueCrypt volume before and after a hidden volume was created within it. 

 
 
The principle is that a TrueCrypt volume is created within another TrueCrypt volume (within the 
free space on the volume). Even when the outer volume is mounted, it is impossible to tell whether 
there is a hidden volume within it or not, because free space on any TrueCrypt volume is always 
filled with random data when the volume is created* (if Quick Format is disabled) and no part of the 
hidden volume can be distinguished from random data.  
 
 

                                                 
* Right before TrueCrypt volume formatting begins, a temporary encryption key, plaintext block, IV and whitening seeds, 
are generated by the built-in random number generator (all these items are stored in RAM and are discarded after 
formatting finishes). The encryption algorithm that the user selected is initialised with the temporary key and the 
ciphertext blocks it produces are used to fill (overwrite) the free space on the volume. IVs are generated as usual (see 
Modes of Operation) except that the IV seed is not retrieved from the volume header but is generated by the random 
number generator. Whitening is also applied as usual (see Whitening) but the whitening values are derived from the 
value generated by the random number generator. 
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The password for the hidden volume must be different from the password for the outer volume. To 
the outer volume, (before creating the hidden volume within it) you should copy some sensitive-
looking files that you do NOT really want to hide. These files will be there for anyone who would 
force you to hand over the password. You will reveal only the password for the outer volume, not 
for the hidden one. Files that are really sensitive will be stored on the hidden volume. 
 
The user can mount the hidden volume the same way as a standard TrueCrypt volume: Select the 
outer volume and enter the password. Whether the hidden or the outer volume will be mounted will 
be controlled by the entered password (i.e., when you enter the password for the outer volume, the 
outer volume will be mounted; when you enter the password for the hidden volume, the hidden 
volume will be mounted).*  
 
 
A hidden volume can be created within any type of TrueCrypt volume, i.e., within a file-hosted 
container or within a partition/device (requires administrator privileges). To create a hidden 
TrueCrypt volume, click on ‘Create Volume’ in the main program window and select “Create a 
hidden TrueCrypt volume”. The Wizard provides help and all information necessary to successfully 
create a hidden TrueCrypt volume. 
  
As it is very difficult or even impossible for an inexperienced user to set the size of the hidden 
volume such that the hidden volume does not overwrite any data on the outer volume (especially 
when the files are fragmented), the Volume Creation Wizard automatically scans the cluster bitmap 
of the outer volume (before the hidden volume is created within it) and determines the maximum 
possible size of the hidden volume.  
Remark: The wizard scans the cluster bitmap to determine the size of the uninterrupted block of 
free space (if there is any) whose end is aligned with the end of the outer volume. This block 
accommodates the hidden volume and therefore the size of this block limits the maximum possible 
size of the hidden volume. 
 
Warning: We recommend that you do not create or copy any more files to outer volume once you 
create a hidden volume within it. If you do, you may overwrite and damage the hidden volume! 
It is, however, possible to open, delete, and rename files stored on the outer volume (after a 
hidden volume is created within), and it is possible to move files from one folder on the outer 
volume to another folder on the outer volume. It is also possible to change the contents of a file 
stored on the outer volume but you have to make sure that the size of the file will not change and 
also that the editor you will use for editing the file does not write a temporary copy of the file to the 
outer volume. 
 
 
A hidden volume can only be created within a FAT TrueCrypt volume (the file system of the outer 
volume must be either FAT12, FAT16, or FAT32). NTFS file system stores various data throughout 
the entire volume (as opposed to FAT) leaving no room for the hidden volume. Therefore, the 
Volume Creation Wizard prevents the user from selecting NTFS as the file system for the outer 
volume. The hidden volume can contain any file system you like and the outer volume (when file-
hosted) can be stored on any file system as well.  
Note: Should you be asked why the file system of the outer volume is FAT, you can answer that 
you left all settings at default (FAT is the default file system for all TrueCrypt volumes). 
 
 

                                                 
* TrueCrypt first attempts to decrypt the standard volume header using the entered password. If it fails, it attempts to 
decrypt the location within the volume where hidden volume headers are normally stored (the third sector from the end of 
the volume) using the entered password again. If successful, the information about the size and the position of the 
hidden volume within the outer volume is retrieved from the header, and the hidden volume is mounted. 
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Warning: If an adversary can make a copy of a (dismounted) TrueCrypt volume at several points 
over time, he will be able to determine which sectors of the volume are changing. If you change the 
contents of a hidden volume (e.g., create/copy new files to the hidden volume or 
update/delete/rename/move files stored on the hidden volume, etc.) and the adversary compares 
the whole host volume with an older copy of it that does not contain these changes, then (after 
being given the password to the outer volume) he might demand an explanation why these sectors 
changed. Your failure to provide a plausible explanation might cause the adversary to suspect that 
the volume contains a hidden volume. 
 
Caution: Make sure that Quick Format is disabled when encrypting a partition/device within which 
you intend to create a hidden volume. 
 
 
If there are any problems when creating a hidden volume, refer to the Troubleshooting section for 
possible solutions. 
 
 
Remark: The timestamp of a file-hosted container (date and time that the container was last accessed, and last modified) 
is never updated when TrueCrypt accesses the container (i.e., after dismounting, attempting to mount, changing or 
attempting to change the password, etc.), which applies both to hidden and normal volumes. 
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Main Program Window 
 
Select File 
 
Allows you to select a file-hosted TrueCrypt volume. After you select it, you can mount it by clicking 
‘Mount’ (see below). It is also possible to select a volume by dragging its icon to the 
‘TrueCrypt.exe’ icon (TrueCrypt will be automatically launched then) or to the TrueCrypt program 
window. 
 

Select Device 
 
Allows you to select a TrueCrypt partition or a storage device (such as floppy disk or USB memory 
stick). After it is selected, it can be mounted by clicking ‘Mount’ (see below). Instead of clicking 
‘Select Device’, you can select a container to mount by dragging its icon over the icon/alias of 
TrueCrypt.exe. 
 
Note: There is a more comfortable way of mounting TrueCrypt partitions/devices – see ‘Auto-
Mount Devices’ for more information.  
 

Mount 
 
To mount a TrueCrypt volume, select a free drive letter from the list in the main window. Then 
select a file or device that hosts the TrueCrypt volume and click ‘Mount’. TrueCrypt will try to mount 
the volume using cached passwords (if there are any) and if none of them works, it asks you to 
enter a password. If you enter the correct password, the volume will be mounted. 
Important: Note that switching users or logging off under Windows XP/2000/2003 does not 
dismount a successfully mounted TrueCrypt volume. Also note that when you exit the TrueCrypt 
application, the TrueCrypt driver continues working and no TrueCrypt volume is dismounted. 
 

Auto-Mount Devices 
 
This function allows you to mount TrueCrypt partitions/devices without having to select them 
manually (by clicking ‘Select Device’). TrueCrypt goes through all available partitions/devices on 
your system one by one and tries to mount each of them as a TrueCrypt volume. Note that 
TrueCrypt partition/device cannot be identified, nor the cipher it has been encrypted with. 
Therefore, the program cannot directly “find” TrueCrypt partitions. Instead, it has to try mounting 
each (even unencrypted) partition/device using all encryption algorithms and all cached passwords 
(if there are any). Therefore, be prepared that this process may take a long time on slow 
computers. Drive letters will be assigned starting from the one that is selected in the drive list in the 
main window. If the password you enter is not correct, mounting is attempted using cached 
passwords (if there are any). If you enter empty password, only the cached passwords will be used 
when attempting to auto-mount partitions/devices. 
 

Dismount 
 
To dismount a TrueCrypt volume basically means to make any access to the data it contains 
impossible. To do so, select a TrueCrypt volume and click on ‘Dismount’.  
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Dismount All 
 
Dismounts all currently mounted TrueCrypt volumes. 
 

Wipe Cache 
 
Clears any passwords cached in driver memory. When there are no passwords in the cache, this 
button is disabled. Up to last four successfully mounted TrueCrypt volume passwords can be 
cached. This allows mounting volumes without having to type their passwords repeatedly. 
TrueCrypt never saves any password to a disk – password cache is located in RAM (however, see 
section Security Precautions). Password caching can be enabled/disabled in the Preferences 
(Tools menu). 
 

Change Password 
 
Allows changing the password of the currently selected TrueCrypt volume (no matter whether the 
volume is hidden or standard). Only the header key is changed – the master key remains 
unchanged. Therefore, reformatting is not necessary and is not performed (i.e., no data will be lost 
after changing the password and the password change will only take a few seconds). 
 
Note that if an adversary knows your password and has access to your volume, he may be able to 
retrieve its master key. If he does, he may be able to decrypt your volume even after you change 
its password (because the master key was not changed). In such a case, create a new TrueCrypt 
volume and move all files from the old volume to this new one. 
 
To change a TrueCrypt volume password, click on ‘Select File’ or ‘Select Device’, then select the 
volume, and click on ‘Change Password’. 
 
PKCS-5 PRF Algorithm: When changing a volume password, you can also select the HMAC hash 
algorithm that will be used in deriving the new volume header key (for more information, see 
Header Key Derivation, Salt, and Iteration Count) and in generating the new salt (for more 
information, see Random Number Generator). 
 

Never Save History 
 
If checked, the file names and paths of the last eight mounted volumes will not be saved in the 
History (which can be displayed by clicking on the Volume combo-box). Note that checking this 
option does not prevent Windows from saving file selector history of last used items (file 
containers). To avoid using the file selector, do not click ‘Select File’ but select the container by 
dragging its icon to the ‘TrueCrypt.exe’ icon (TrueCrypt will be automatically launched then). 
 

Exit 
 
Terminates the TrueCrypt application. The driver continues working; no TrueCrypt volumes are 
dismounted. 
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Program Menu 
 
Note: Only the menu items that are not self-explanatory are described in this documentation. 
 

File -> Exit 
 
Terminates the TrueCrypt application. The driver continues working and no TrueCrypt volumes are 
dismounted. When running in ‘traveller’ mode, the TrueCrypt driver will be unloaded when it is no 
longer needed (e.g., when the main application and/or the last instance of the Volume Creation 
Wizard is closed and no TrueCrypt volumes are mounted). 
 

Volumes -> Auto-Mount All Device-Hosted Volumes 
 
See section Auto-Mount Devices. 
 

Tools -> Clear Volume History 
 
Clears the list containing file names and paths of the last eight successfully mounted TrueCrypt 
volumes. 
 

Tools -> Traveller Disk Setup 
 
See Chapter Traveller Mode. 
 

Tools -> Preferences 
 
Wipe cached passwords on exit 
 
If enabled, passwords cached in driver memory will be cleared when exiting TrueCrypt.  
 
 
Cache passwords in driver memory 
 
When checked, up to last four successfully mounted TrueCrypt volume passwords will be cached 
in driver memory. Then, later, volumes can be mounted using a cached password without having 
to type it again. A cached password is never saved to a disk. It is only temporarily stored in RAM. 
Sensitive parts of the TrueCrypt driver memory are prevented from being swapped to disk. 
 
 
Open Explorer window for successfully mounted volume 
 
If this option is checked, then after a TrueCrypt volume has been successfully mounted, an 
Explorer window showing the root directory of the volume (e.g., T:\) will be automatically open. 
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Close all Explorer windows of volume being dismounted 
 
Sometimes, dismounting a TrueCrypt volume is not possible due to the fact that some files or 
folders located on the volume are in use or “locked”. This also applies to Explorer windows 
displaying directories located on TrueCrypt volumes. When this option is checked, all such 
windows will be automatically closed before dismounting, so that the user does not have to close 
them manually. 
 
 

Mounting TrueCrypt Volumes 
 
If you have not done so yet, please read the sections ‘Mount’ and ‘Auto-Mount Devices’. 

 
Cache Password in Driver Memory 
 
This option can be set in the password entry dialog. When checked, the volume password you 
enter will be cached in driver memory (if the password is correct). Then, later, volumes can be 
mounted using the cached password without having to type it again. Up to four passwords can be 
cached. TrueCrypt never saves any password to any disk (it only temporarily stores them in RAM). 
Note that turning the password cache off will not clear it (click Wipe Cache to do so). 

 
Mount Options 
 
Mount options affect the parameters of the volume being mounted. The Mount Options dialog can 
be opened by clicking on the Mount Options button in the password entry dialog. When a correct 
password is cached, volumes are automatically mounted after you click Mount. If you need to 
change mount options for a volume being mounted using a cached password, hold Control while 
clicking Mount, or select Mount with Options from the Volumes menu.  
Default mount options can be configured in the main program preferences (Tools -> Preferences).  
The following mount options are available: 
 
Mount volume as read-only 
 
When checked, it will not be possible to write any data to the mounted volume. Note that Windows 
2000 do not allow NTFS volumes to be mounted as read-only.  
 
Mount volume as removable medium 
 
Check this option, if you need to prevent Windows from automatically creating the ‘Recycled’ 
and/or ‘System Volume Information’ folders on the volume (these folders are created by the 
Recycle Bin and System Restore facilities). 
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Traveller Mode 
 
TrueCrypt can run in so-called ‘traveller’ mode, which means that it does not have to be installed 
on the operating system under which it is run. However, there are two things to keep in mind:  

1) You need administrator privileges in order to able to run TrueCrypt in ‘traveller’ mode. 
2) After examining the registry file, it may be possible to tell that TrueCrypt was run on a 

Windows system even if it is run in traveller mode. 
If you need to solve these problems, we recommend using BartPE for this purpose. For further 
information on BartPE, see the question “Is it possible to encrypt my operating system boot 
partition?” in the section Frequently Asked Questions. 
 
 
There are two ways to run TrueCrypt in ‘traveller’ mode.  

1) After you unpack the binary distribution archive, you can directly run TrueCrypt.exe. 
2) You can use the Traveller Disk Setup facility to prepare a special ‘traveller’ disk and launch 

TrueCrypt from there.  
The second option has several advantages, which will be described in the following paragraphs. 
 
 
Tools -> Traveller Disk Setup 
 
AutoRun Configuration (autorun.inf) 
 
In this section you can configure the ‘traveller’ disk to automatically start TrueCrypt or mount a 
specified TrueCrypt volume when the ‘traveller’ disk is inserted. This is accomplished by creating a 
special script file called ‘autorun.inf’ on the traveller disk. This file is automatically executed by the 
operating system each time the ‘traveller’ disk is inserted. Note that this feature only works for 
removable storage devices such as CD/DVD (Windows XP SP2 is required for this feature to work 
with USB memory sticks) and only when it is enabled in the operating system.  
Also note that the ‘autorun.inf’ file must be in the root directory of the traveller disk (i.e., for 
example G:\, X:\, or Y:\ etc.) in order for this feature to work. 
 
Include TrueCrypt Volume Creation Wizard 
 
Check this option, if you need to create new TrueCrypt volumes using TrueCrypt run from the 
‘traveller’ disk you will create. Unchecking this option saves space on the ‘traveller’ disk. 
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Encryption Algorithms 
 
TrueCrypt volumes can be encrypted using one of the following algorithms: 
 

Algorithm Designer(s) Key Size (Bits) Block Size 
(Bits) Mode 

     

AES J. Daemen, V. Rijmen 256 128 CBC 

Blowfish B. Schneier 448 64 CBC 

CAST5 C. Adams, S. Tavares 128 64 CBC 

Serpent R. Anderson, E. Biham, L. Knudsen 256 128 CBC 

Triple DES IBM, NSA 3*56 64 Outer-CBC 

Twofish B. Schneier, J. Kelsey, D. Whiting, 
D. Wagner, C. Hall, N. Ferguson 256 128 CBC 

AES-Blowfish  256; 448 128; 64 Inner-CBC 

AES-Blowfish-Serpent  256; 448; 256 128; 64; 128 Inner-CBC 

AES-Twofish  256; 256 128 Outer-CBC 

AES-Twofish-Serpent  256; 256; 256 128 Outer-CBC 

Serpent-AES  256; 256 128 Outer-CBC 

Serpent-Twofish-AES  256; 256; 256 128 Outer-CBC 

Twofish-Serpent  256; 256 128 Outer-CBC 

     
 
A random value, unique to each sector and volume, is used as the IV (for more information, please 
see Modes of Operation).  
 

AES 
 
The Advanced Encryption Standard specifies a FIPS-approved cryptographic algorithm (Rijndael, 
designed by Joan Daemen and Vincent Rijmen, published in 1998) that may be used by US 
federal departments and agencies to cryptographically protect sensitive (unclassified) information 
[3]. 256-bit key, 14 rounds (AES-256, published in 2001). 
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In June 2003, after the NSA (US National Security Agency) has conducted a review and analysis 
of AES, the U.S. CNSS (Committee on National Security Systems) announces in [2] that the 
design and strength of AES-256 (and AES-192) are sufficient to protect classified information up to 
the TOP SECRET level. This is applicable to all U.S. Government Departments or Agencies that 
are considering the acquisition or use of products incorporating the Advanced Encryption Standard 
(AES) to satisfy Information Assurance requirements associated with the protection of national 
security systems and/or national security information [2].  
 

Blowfish 
 
Designed by Bruce Schneier in 1993. Unpatented, license-free, available free for all uses. 
TrueCrypt uses Blowfish with 16 rounds and a 448-bit key. Blowfish is the fastest of the 
implemented ciphers.  
 

CAST5 
 
CAST5, alias CAST-128, was designed by Carlisle Adams and Stafford Tavares, and published in 
1997. 128-bit key, 64-bit block. This encryption algorithm is described in U.S. patent number 
5,511,123 [1]. However, CAST5 is royalty-free both for commercial and non-commercial uses [6]. It 
is also one of the encryption algorithms that are officially used by the Canadian government to 
cryptographically protect sensitive (unclassified) information [17]. 
 

Serpent 
 
Designed by Ross Anderson, Eli Biham, and Lars Knudsen. Published in 1998. 256-bit key, 128-bit 
block. Serpent was one of the AES finalists. It was not selected as the proposed AES algorithm 
even though it appeared to have a higher security margin than the winning Rijndael [4]. Concretely, 
Serpent appeared to have a high security margin, while Rijndael appeared to have only an 
adequate security margin [4]. Rijndael has also received some criticism suggesting that its 
mathematical structure may lead to attacks in the future [4].  
 
In [5] the Twofish team presents a table of safety factors for the AES finalists. Safety factor is 
defined as: number of rounds of the full cipher divided by the largest number of rounds that has 
been broken. Hence, a broken cipher has the lowest safety factor 1. Serpent had the highest safety 
factor of the AES finalists: 3.56 (for all supported key sizes). Rijndael-256 had a safety factor of 
1.56 and Rijndael-128 had the lowest safety factor of the finalists: 1.11. 
 
In spite of these facts, Rijndael was considered an appropriate selection for the AES for its 
combination of security, performance, efficiency, implementability, and flexibility [4]. At the last AES 
conference, Rijndael got 86 votes, Serpent got 59 votes, Twofish 31 votes, RC6 23 votes and 
MARS 13 votes [18, 19].*  
 

Triple DES 
 
Triple DES, published in 1978, is three iterations (encrypt-decrypt-encrypt) of the DES cipher 
designed by IBM and NSA (in 1976). Outer-CBC mode [16] and three independent 56-bit keys are 
used (1 per iteration) [13]. Note that this cipher is very slow.  

                                                 
* These are positive votes. If negative votes are subtracted from the positive votes, the following results are obtained: 
Rijndael: 76 votes, Serpent: 52 votes, Twofish: 10 votes, RC6: -14 votes, MARS: -70 votes [19]. 
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Twofish 
 
Designed by Bruce Schneier, David Wagner, John Kelsey, Niels Ferguson, Doug Whiting, and 
Chris Hall. Published in 1998. 256-bit key, 128-bit block. Twofish was one of the AES finalists. 
This cipher uses key-dependent S-boxes. Twofish may be viewed as a collection of 2128 different 
cryptosystems, where 128 bits derived from a 256-bit key control the selection of the cryptosystem 
[4]. In [23], the Twofish team asserts that key-dependent S-boxes constitute a form of security 
margin against unknown attacks [4]. 

 
AES-Blowfish 
 
Two ciphers in a cascade [15, 16] operating in inner-CBC mode. Each sector is first encrypted with 
Blowfish (448-bit key, 64-bit block) and then with AES (256-bit key, 128-bit block). Each of the 
cascaded ciphers uses its own key. All keys are mutually independent (note that header keys are 
independent as well, even though they are derived from one password – see Header Key 
Derivation, Salt, and Iteration Count). See above for information on the individual cascaded 
ciphers. 
 

AES-Blowfish-Serpent 
 
Three ciphers in a cascade operating in inner-CBC mode. Each sector is first encrypted with 
Serpent (256-bit key, 128-bit block), then with Blowfish (448-bit key, 64-bit block), and finally with 
AES (256-bit key, 128-bit block). Each of the cascaded ciphers uses its own key. All keys are 
mutually independent (note that header keys are independent as well, even though they are 
derived from one password – see Header Key Derivation, Salt, and Iteration Count). See above for 
information on the individual cascaded ciphers. 
 

AES-Twofish 
 
Two ciphers in a cascade operating in outer-CBC mode. Each 128-bit block is first encrypted with 
Twofish (256-bit key) and then with AES (256-bit key). Each of the cascaded ciphers uses its own 
key. All keys are mutually independent (note that header keys are independent as well, even 
though they are derived from one password – see Header Key Derivation, Salt, and Iteration 
Count). See above for information on the individual cascaded ciphers. 
 

AES-Twofish-Serpent 
 
Three ciphers in a cascade operating in outer-CBC mode. Each 128-bit block is first encrypted with 
Serpent (256-bit key), then with Twofish (256-bit key), and finally with AES (256-bit key). Each of 
the cascaded ciphers uses its own key. All keys are mutually independent (note that header keys 
are independent as well, even though they are derived from one password – see Header Key 
Derivation, Salt, and Iteration Count). See above for information on the individual cascaded 
ciphers. 
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Serpent-AES 
 
Two ciphers in a cascade operating in outer-CBC mode. Each 128-bit block is first encrypted with 
AES (256-bit key) and then with Serpent (256-bit key). Each of the cascaded ciphers uses its own 
key. All keys are mutually independent (note that header keys are independent as well, even 
though they are derived from one password – see Header Key Derivation, Salt, and Iteration 
Count). See above for information on the individual cascaded ciphers. 

 
Serpent-Twofish-AES 
 
Three ciphers in a cascade operating in outer-CBC mode. Each 128-bit block is first encrypted with 
AES (256-bit key), then with Twofish (256-bit key), and finally with Serpent (256-bit key). Each of 
the cascaded ciphers uses its own key. All keys are mutually independent (note that header keys 
are independent as well, even though they are derived from one password – see Header Key 
Derivation, Salt, and Iteration Count). See above for information on the individual cascaded 
ciphers. 
 

Twofish-Serpent 
 
Two ciphers in a cascade operating in outer-CBC mode. Each 128-bit block is first encrypted with 
Serpent (256-bit key) and then with Twofish (256-bit key). Each of the cascaded ciphers uses its 
own key. All keys are mutually independent (note that header keys are independent as well, even 
though they are derived from one password – see Header Key Derivation, Salt, and Iteration 
Count). See above for information on the individual cascaded ciphers. 
 

Supported Operating Systems 
 
TrueCrypt runs on the following operating systems: 
 

• Windows XP 
• Windows 2000 
• Windows (Server) 2003 
 

We recommend Windows XP (at least Service Pack 1) or later as the optimum environment for 
running TrueCrypt.  
 
Windows 64-Bit Edition is currently not supported. 
 
Remark: TrueCrypt also runs on the Windows “Longhorn” operating system (beta version of the 
future successor to Windows XP). 
 

Command Line Usage 
 
/help or /?   Displays command line help. 
/volume or /v  File and path name of a TrueCrypt volume. To mount a hard disk partition, 

use, for example, /v \Device\Harddisk1\Partition3 (to determine 
the path to a partition, run TrueCrypt and click Select Device). 
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/letter or /l Driver letter to mount the volume as. When /l is omitted and when /a is 
used, the first free drive letter is used. 

/explore or /e  Opens an Explorer window after a volume has been mounted. 
/beep or /b  Beeps after a volume has been successfully mounted or dismounted. 
/auto or /a  If no parameter is specified, automatically mounts the volume. If devices is  
   specified as the parameter, auto-mounts all currently accessible  

device/partition-hosted TrueCrypt volumes. 
/dismount or /d Dismounts the given volume (specified by its drive letter) or when no volume 

is specified, dismounts all currently mounted TrueCrypt volumes. 
/force or /f Forces dismount (if the volume to be dismounted contains files being used 

by the system or an application) and forces mounting in shared mode (i.e., 
without exclusive access). 

/cache or /c  y: enables, n: disables the password cache. Note that turning the 
password cache off will not clear it. 

/history or /h  y: enables, n: disables the history. 
/wipecache or /w Wipes any passwords cached in the driver memory. 
/password or /p The volume password. If the password contains spaces, it must be enclosed 

in quotation marks (e.g., /p “My Password”). Warning: This method of 
entering a volume password is not secure, particularly when you save the 
password in an unecrypted batch file, or when an unencrypted command 
prompt history log is being saved to disk. Consider using /q /a instead. 

/quiet or /q Quiet mode. When used along with /auto and if no cached password is 
correct, the password prompt appears (the main TrueCrypt window is not 
displayed). This could increase the level of privacy in multi-user 
environments. Program settings are not loaded/saved from/to Windows 
registry file when quiet mode is enabled. 

/mountoption or /m ro: mount as read-only; rm: mount as removable medium 
 
 
 
Syntax 
 
truecrypt [/v volume] [/d [letter]] [/l letter] [/m {rm|ro}] [/e] [/b] 
[/p password] [/h {y|n}] [/q] [/c {y|n}] [/w] [/a [devices]] [/f] 
 
The order of the parameters is not important. Whitespaces between parameters and parameter 
values do not matter. 
 
 
 
Examples 
 
Mounting a volume called 'myvolume.tc' using the password ‘MyPassword’, as the drive letter X, 
TrueCrypt will open an explorer window and beep, mounting will be automatic: 
 
truecrypt /v myvolume.tc /lx /a /p MyPassword /e /b 
 
Mounting a volume called ' myvolume.tc' as the first free drive letter, using the password prompt 
(the main program window will not be displayed): 
 
truecrypt /v myvolume.tc /a /q 
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Security Precautions 
 
This section informs about things that (although most of them are not directly connected with 
TrueCrypt) might affect the security of sensitive data. Please note that it is impossible to inform 
here about all security risks. There are, unfortunately, too many of them and it would require 
thousands of pages to describe them. 

 
Swap File 
 
Also called ‘paging file’; Windows uses this file (usually stored on a hard disk) to hold parts of 
programs and data files that do not fit in memory. This means that sensitive data, which you 
believe are only stored in RAM, can actually be written unencrypted to a hard disk by Windows 
without you knowing.  
TrueCrypt uses the non-paged pool to store cached passwords, encryption keys, IVs and other 
sensitive volume data, so this data cannot be leaked to paging files. However, TrueCrypt cannot 
prevent the contents of sensitive files that are opened in RAM from being saved unencrypted to a 
swap file (note that when you open a file stored on a TrueCrypt volume, for example, in a text 
editor, then the contents of that file is stored unencrypted in RAM). 
Therefore, we strongly recommend that Windows XP users disable the swap file feature, at least 
for each session during which they work with sensitive data. To do so, right-click the My Computer 
icon on the desktop or in the Start Menu, and then select Properties -> Advanced tab -> section 
Performance -> Settings -> Advanced tab -> section Virtual Memory -> Change -> No Paging File -
> Set -> OK. 
As far as we know, Windows 2000 users unfortunately cannot disable the swap file feature 
completely. We recommend that Windows 2000 users configure their Windows security settings to 
clear the paging files every time the computer shuts down (refer to your Windows manual or 
www.microsoft.com for more information). 
 

Hibernation Mode 
 
When a computer hibernates, the contents of its system memory and of open files are written to a 
storage file on the hard drive. TrueCrypt cannot prevent the contents of sensitive files opened in 
RAM from being saved unencrypted to a hibernation storage file (note that when you open a file 
stored on a TrueCrypt volume, for example, in a text editor, then the contents of that file is stored 
unencrypted in RAM). Therefore, we strongly recommend that you prevent or disable hibernation 
mode on your computer at least for each session during which your work with any sensitive data.  

 
Multi-User Environment 
  
Keep in mind, that the contents of a mounted TrueCrypt volume is visible (accessible) to all logged 
on users (NTFS file permissions can be configured to prevent this). Also note that switching users 
or logging off Windows does not dismount a successfully mounted TrueCrypt volume (unlike 
system restart, which dismounts all mounted TrueCrypt volumes).  
 
 
Data Corruption 
 
Due to hardware or software errors/malfunctions, files stored on a TrueCrypt volume may become 
corrupted. Therefore, we strongly recommend that you backup all your important files regularly 

http://www.microsoft.com/
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(this, of course, applies to any important data, not just to encrypted data stored on TrueCrypt 
volumes). 
 

Incompatibilities 
 
We are currently not aware of any incompatibilities. 
 

  

Known Issues & Limitations 
 
• Network volumes are not supported (the contents of a mounted TrueCrypt volume can be 

shared over a network but it is not possible to mount a TrueCrypt volume stored on a network 
volume). 
 

• TrueCrypt-encrypted floppy disks: When a floppy disk is ejected and another one is inserted, 
garbage will be read/written to the disk, which could lead to data corruption. This affects only 
raw floppy disk volumes (not file-hosted TrueCrypt containers stored on floppy disks). 

 
 

Troubleshooting 
 
This section presents possible solutions to common problems that you may run into when using 
TrueCrypt. If your problem is not listed here, it might be listed in one of the following sections:  
 
Incompatibilities 
Known Issues & Limitations 
Frequently Asked Questions 
 
 
 
PROBLEM:  
 
After successfully mounting a volume, it cannot be accessed via Windows Explorer (it is not visible 
in the ‘My Computer’ list, etc.) even though the volume is displayed in TrueCrypt as mounted.  
 
PROBABLE CAUSE:  

 
A Windows Explorer issue. 

 
POSSIBLE SOLUTION: 

 
Click Tools -> Refresh Drive Letters. If it does not help, restart Windows Explorer (for example, by 
logging off and on). 
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PROBLEM:  
 
When trying to create a hidden volume, its maximum possible size is unexpectedly small (there is 
much more free space than this on the outer volume). 
 
PROBABLE CAUSE:  

 
Fragmentation  
 
OR 
 
Too small cluster size + too many files/folders in the root directory of the outer volume. 

 
POSSIBLE SOLUTION: 
 
Defragment the outer volume (mount it, right-click its drive letter in the My Computer window, click 
Properties, select the Tools tab, and click Defragment Now). After the volume is defragmented, exit 
Disk Defragmenter and try to create the hidden volume again.  
 
If this does not help, delete all files and folders on the outer volume by pressing Shift+Delete, not 
by formatting, (do not forget to disable the Recycle Bin and System Restore for this drive 
beforehand) and try creating the hidden volume on this completely empty outer volume again (for 
testing purposes only). If the maximum possible size of the hidden volume does not change even 
now, the cause of the problem is very likely an extended root directory. If you did not use the 
‘Default’ cluster size (the last step in the Wizard), reformat the outer volume and this time leave the 
cluster size at ‘Default’.  
 
If it does not help, reformat the outer volume again and copy less files/folders to its root folder than 
you did last time. If it does not help, keep reformatting and decreasing the number of files/folders in 
the root folder. If this is unacceptable or if it does not help, reformat the outer volume and select a 
larger cluster size. If it does not help, keep reformatting and increasing the cluster size, until the 
problem is solved. Should you be asked why the volume has such a large cluster size, you can 
answer that you prefer higher performance (see the section Cluster Size for more information). 
 
 
PROBLEM:  
 
I cannot encrypt a partition/device because TrueCrypt Volume Creation Wizard says it is in use. 

 
POSSIBLE SOLUTION: 

 
First make sure that you are not trying to encrypt the operating system boot partition (TrueCrypt 
does not support this). Then close, disable, or uninstall all programs that might be using the 
partition/device in any way (for example an anti-virus utility). If it does not help, right-click the My 
Computer icon on your desktop and select Manage -> Storage -> Disk Management. Then right-
click the partition that you want to encrypt, and click Change Drive Letter and Paths, then click 
Remove and OK. Restart the operating system. 
 
 



 

TrueCrypt User’s Guide. Copyright © 2004-2005 TrueCrypt Foundation. All rights reserved. 
 

24 

PROBLEM:  
 
When creating a hidden volume, the Wizard reports that the outer volume cannot be locked.  
 
PROBABLE CAUSE:  

 
The outer volume contains files being used by one or more applications. 

 
POSSIBLE SOLUTION: 

 
Close all applications that are using files on the outer volume. If it does not help, try disabling or 
uninstalling any anti-virus utility you use. 
 
 
PROBLEM:  
 
One of the following problems occurs: 
 
1. A TrueCrypt volume cannot be mounted  
2. NTFS TrueCrypt volumes cannot be created 
 
In addition, the following error may be reported: "The process cannot access the file because it is 
being used by another process."  
 
PROBABLE CAUSE:  

 
This is probably caused by an interfering application. Note that this is not a bug in TrueCrypt. The 
operating system reports to TrueCrypt that the device is locked for an exclusive access by an 
application (so TrueCrypt is not allowed to access it). 

 
POSSIBLE SOLUTION: 

 
It usually helps to disable or uninstall the interfering application, which is usually an anti-virus utility, 
a disk management application, etc. 
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Frequently Asked Questions 
 
The most recent version of the TrueCrypt FAQ is available at: 
http://truecrypt.sourceforge.net/faq.php 
 
 
Q: I forgot the password – is there any way to recover the files from my TrueCrypt volume? 
 
A: TrueCrypt does not contain any mechanism or facility that would allow partial or complete 
recovery of your encrypted data without knowing the correct password or the key used to encrypt 
the data. The only way to recover your files is to try to ‘crack’ the password or the key, but it could 
take thousands or millions of years depending on the length and quality of the password, or on the 
key size, on the software/hardware efficiency, and on other factors.  
 
 
Q: Does TrueCrypt save my password to a disk? 
 
A: No.  
 
 
Q: Is some hash of my password stored somewhere? 
 
A: No.  
 
 
Q: Is the key size limited to 160 bits when I use HMAC-SHA-1 or HMAC-RIPEMD-160? 
 
A: No, TrueCrypt never uses an output of a hash function (nor of a HMAC algorithm) directly as an 
encryption key. See the section ‘Header Key Derivation, Salt, and Iteration Count’ for more 
information. 
 
 
Q: What is the maximum possible size of a TrueCrypt volume? 
 
A: TrueCrypt volumes can be up to 9223372036 GB. However, you need to take into account the 
following: the limitations of the file system that the container will be stored on, the limitations of the 
file system of the container itself, the hardware connection standard, and your operating system 
limitations. Remember that file-hosted containers stored on the FAT32 file system cannot be larger 
than 4 GB (if you need a larger volume, store it on the NTFS file system or, instead of creating a 
file-hosted volume, encrypt a partition). Also note that any FAT32 volume, encrypted or not, cannot 
be larger than 2048 GB (if you need larger volumes, format them as NTFS). 
 
 
Q: Which cipher is the most secure? 
 
A: Unfortunately, it is impossible to answer this question. However, all ciphers implemented in 
TrueCrypt are well known and trusted. No weak cipher has been implemented in TrueCrypt. 
  
 
Q: Is it possible to install an application to a TrueCrypt volume and run it from there? 
 
A: Yes. 

http://truecrypt.sourceforge.net/faq.php
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Q: How does TrueCrypt verify that the correct password was entered? 
 
See the section Technical Details – Encryption Scheme. 
 
 
Q: Does TrueCrypt support hardware/software RAID and dynamic volumes? 
 
A: Yes, it does. If you intend to format a dynamic volume as a TrueCrypt volume, keep in mind that 
after you create the dynamic volume (using the Windows Disk Management tool), you must restart 
the operating system in order for the volume to be available/displayed in the ‘Select Device’ 
window of the TrueCrypt Volume Creation Wizard. Also note that, in the ‘Select Device’ window, a 
dynamic volume is not displayed as a single device. Instead, all the volumes that the dynamic 
volume consists of are displayed and you can select any of them in order to format the entire 
dynamic disk. 
 
 
Q: Is it possible to mount a TrueCrypt container that is stored on a CD or DVD? 
 
A: Yes, it is. However, if you need to mount a TrueCrypt volume that is stored on a read-only 
medium (such as a CD or DVD) under Windows 2000, the file system of the TrueCrypt volume 
must be FAT (Windows 2000 cannot mount NTFS file system on read-only media).  
 
 
Q: What will happen if I format a TrueCrypt partition? 
 
See the question “Is it possible to change the file system of an encrypted volume?” in this FAQ. 
 
 
Q: Is it possible to change the file system of an encrypted volume? 
 
A: Yes, when mounted, TrueCrypt volumes can be formatted as FAT12, FAT16, FAT32, or NTFS. 
The volumes behave as standard disk devices so you can right-click the device icon (for example 
in ‘My Computer’ list) and select 'Format'. The actual volume contents will be lost, the whole 
volume will remain encrypted though. If you format a TrueCrypt-encrypted partition when the 
TrueCrypt volume that the partition hosts is not mounted, then the volume will be destroyed, and 
the partition will not be encrypted anymore (it will be empty). 
  
 
Q: Is it possible to change the password for a ‘hidden’ volume? 
 
A: Yes, the password change dialog works both for standard and hidden volumes. Just type the 
password for the hidden volume in the ‘Current Password’ field of the ’Volume Password Change’ 
dialog.  
 
Remark: TrueCrypt first attempts to decrypt the standard volume header and if it fails, it attempts to decrypt 
the location within the volume where the hidden volume header may be stored (if there is a hidden volume 
within). In case it is successful, the password change applies to the hidden volume. (Both attempts use the 
password typed in the  ‘Current Password’ field.) 
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Q: How do I decrypt a TrueCrypt partition permanently? 
 
A: If you format a TrueCrypt-encrypted partition when the TrueCrypt volume hosted by the partition 
is not mounted, then the volume will be destroyed and the partition will not be encrypted anymore 
(it will be empty). Note that the contents of the TrueCrypt volume will be lost. 
 
 
Q: How do I burn a TrueCrypt container larger than 2 GB onto a DVD? 
  
A: The DVD burning software you use should allow you to select the format of the DVD. If it does, 
select the UDF format (ISO format does not support files over 2 GB). 
 
 
Q: The Windows file selector remembers the path of the last container I mount. Is there a 
way to prevent this? 
 
A: There are several ways to prevent this. One is to edit the Windows registry files correspondingly 
(see the Windows documentation for more information). Another way is not to use the file selector 
to select a TrueCrypt container. Instead, drag the icon of the container to the 'TrueCrypt.exe' icon 
(TrueCrypt will be automatically launched then) or drag it to the TrueCrypt program window. 
 
 
Q: How do I encrypt a partition without losing the data currently stored on it? 
  
A: Unfortunately, TrueCrypt does not allow this, and we do not plan to implement such feature 
either. The reason being that we consider this technique potentially insecure (and methods to 
make it secure would decrease the encryption speed unacceptably). For more information, refer to 
[21]. 
 
 
Q: Can I use tools like chkdsk, Defrag, etc. on the contents of a TrueCrypt volume?  
 
A: Yes, TrueCrypt volumes behave like real physical disk devices, so it is possible to use any 
filesystem checking/repairing/defragmenting tools on the contents of a mounted TrueCrypt volume. 
 
 
Q: Is it possible to encrypt my operating system boot partition? 
 
A: No, TrueCrypt does not allow this. However, there are ways to ensure that the volume where 
operating system resides is read-only, which should prevent information leakage (registry, 
temporary files, etc., are stored in RAM) and make it impossible for an adversary to install a Trojan 
horse on the system. One of the ways is using BartPE. BartPE stands for “Bart's Preinstalled 
Environment”, which is essentially the Windows operating system prepared in a way that it can be 
entirely stored on and booted from a CD/DVD (registry, temporary files, etc., are stored in RAM – 
hard disk is not used at all and does not even have to be present). The freeware Bart's PE Builder 
can transform a Windows XP installation CD into BartPE.  
If you use TrueCrypt 3.1 or later, you do not even need any TrueCrypt plug-in for BartPE. You can 
simply run TrueCrypt in ‘traveller’ mode under the BartPE system from a BartPE disk itself or from 
any other location where the TrueCrypt system files (i.e., ‘TrueCrypt.exe’, ‘truecrypt.sys’, etc.) are 
stored. The type of the CD or DVD on which you store BartPE should be “write once, read many" 
(for example CD-R), because rewritable disk types (such as CD-RW) might allow an adversary to 
alter the contents of the disk. 
 

http://www.nu2.nu/pebuilder/
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Q: Can I mount a TrueCrypt volume stored on another TrueCrypt volume?  
 
A: Yes, TrueCrypt volumes can be nested without any limitation. 
 
 
Q: Can I run TrueCrypt with another on-the-fly disk encryption tool on one system? 
 
A: We are not aware of any on-the-fly encryption tool that would cause problems when run with 
TrueCrypt, or vice versa. 
 
 
Q: Can I resize a TrueCrypt partition?  
 
A: Unfortunately, TrueCrypt does not support this. Resizing a TrueCrypt partition using a program 
such as PartitionMagic will, in most cases, corrupt its contents. 
 
 
Q: Can I use TrueCrypt if I do not have administrator privileges? 
 
A: Users without administrator privileges can mount, dismount and create TrueCrypt volumes. 
They cannot encrypt/format partitions (they can only create file containers), cannot create NTFS 
volumes, and cannot install/uninstall TrueCrypt. 
 
 
Q: Why is it not possible to create arbitrary cascades? 
 
A: The reason is that the encryption algorithm (and the mode of operation) that a TrueCrypt volume 
has been encrypted with is unknown. The correct encryption algorithm has to be determined 
through the process of trial and error. If we added the support for creating arbitrary cascades, the 
number of encryption algorithms to attempt mounting with would increase tremendously. The time 
needed to mount a volume would no longer be acceptable especially on slow PCs.  
 
 
Q: What will happen when a part of a TrueCrypt volume becomes corrupted? 
 
A: Data within each sector (sector is 512 bytes) are chained (see ‘Modes of Operation’) so when a 
block becomes corrupted, each successive block within the sector will also become corrupted 
(block size is either 8 or 16 bytes, depending on the encryption algorithm). Corrupting the volume 
header will, in most cases, make the volume impossible to mount. 
 
 
Q: Will I always be able to mount a TrueCrypt container no matter how fragmented it is? 
 
A: Yes. 
 
 
Q: Is it necessary to restart the computer before copying a TrueCrypt container? 
 
A: No, it is not necessary.  
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Q: Is it secure to create a new container by cloning an existing container? 
 
A: You should always use the Volume Creation Wizard to create a new TrueCrypt volume. If you 
copy a container and then start using both this container and its clone in a way that both eventually 
contain different data, then you could aid cryptanalysis. The reason is that both volumes would 
share the same key, IVs, whitening values, etc. 
 
 
Q: Do I have to “wipe” free space and/or files on a TrueCrypt volume? 
 
[“Wiping” – secure deletion; overwriting sensitive data in order to render them unrecoverable.]  
 
A: If you believe that an adversary will be able to decrypt the volume (for example that he will make 
you reveal the password), then the answer is yes. Otherwise, it is not necessary, because the 
volume is entirely encrypted.  
 
 
Q: How is TrueCrypt related to E4M? 
 
A: TrueCrypt 1.0 was derived from E4M 2.02a. For information on differences between E4M and 
TrueCrypt, please see Version History. 
 
 
Q: Will TrueCrypt be open-source and free forever? 
 
A: Yes, it will. No commercial version is planned and never will be. We believe in open-source and 
free security software.  
 
Remark: We know that there are certain individuals trying to distribute TrueCrypt as paid and 
closed-source software. We are not affiliated with these individuals. 
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Uninstalling TrueCrypt 
 
To uninstall TrueCrypt, open the Windows Control Panel and select ‘Add/Remove Programs’, 
locate TrueCrypt and click the ‘Add/Remove’ button. 
 
Normally, all TrueCrypt files except the uninstaller (WindowsPath\TrueCryptSetup.exe) 
should be removed, and most of the changes made to the registry should be undone. 
 
No TrueCrypt volume will be removed when you uninstall TrueCrypt. You will be able to mount 
your TrueCrypt volume(s) again after you install TrueCrypt. 

 

TrueCrypt System Files 
 
WindowsPath\TrueCryptSetup.exe (uninstaller) 
 
WindowsPath\SYSTEM32\DRIVERS\truecrypt.sys  (driver) 
 
 
Note: Replace WindowsPath with your Windows installation path (e.g., C:\WINDOWS) 
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Technical Details 
Notation 
 
C  Ciphertext block 
 
DK()  Decryption algorithm using decryption key K 
 
EK()  Encryption algorithm using encryption key K 
 
H()  Hash function (e.g., RIPEMD-160) 
 
i  Block index for n-bit blocks; n is context-dependent 
 
K  Encryption/decryption key 
 
m  Block index for 64-bit blocks 
 
n  Block index for 128-bit blocks 
 
P  Plaintext block 
 
R  Randomness pool 
 
W  Whitening value 
 
^  Exclusive-OR operation (XOR) 
 
⊕  Modulo 2n addition, where n is the bit size of the left-most operand and of the 

resultant value (e.g., if the left operand is a 1-bit value, and the right operand is a 
2-bit value, then: 1 ⊕ 0 = 1;  1 ⊕ 1 = 0;  1 ⊕ 2 = 1;  1 ⊕ 3 = 0;  0 ⊕ 0 = 0;  0 ⊕ 1 = 1;  
0 ⊕ 2 = 0;  0 ⊕ 3 = 1) 
 

||  Concatenation 
 

Encryption Scheme 
 
When mounting a TrueCrypt volume (assume there are no cached passwords), the following steps 
are performed: 
 

1. The first 512 bytes (i.e., the standard volume header) of the volume are read into RAM, out 
of which the first 64 bytes are the salt (see TrueCrypt Volume Format Specification).  
 

2. 512 bytes at byte 1536 (offset) from the end of the volume are read into RAM (see 
TrueCrypt Volume Format Specification). If there is a hidden volume within this volume, at 
this point we have read its header (whether or not there is a hidden volume has to be 
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determined by attempting to decrypt this data).  
 

3. Now, TrueCrypt attempts to decrypt the standard volume header and the candidate for the 
hidden volume header, read in (1) and (2). All data used and generated in the course of the 
process of decryption are kept in RAM (TrueCrypt never saves them to disk). The following 
parameters are unknown* and have to be determined through the process of trial and error 
(i.e., by testing all possible combinations of the following): 
 

a. PRF used in deriving the header key (as specified in PKCS #5 v2.0; see the section 
Header Key Derivation, Salt, and Iteration Count), which can be one of the 
following: 
HMAC-SHA-1, HMAC-RIPEMD-160. 
A password entered by the user and the salt read in (1) or (2) are passed to the header 
key derivation function, which produces a sequence of values (see the section 
Header Key Derivation, Salt, and Iteration Count) from which the header encryption 
key and IV (used to decrypt the volume header) are derived. 

b. Encryption algorithm(s): 
AES-256, Blowfish, CAST5, Serpent, Triple DES, Twofish 

c. Number of ciphers to use (whether a cascade or single encryption). 
d. Mode of operation: CBC, inner-CBC, outer-CBC 
e. Block size(s) 
f. Key size(s) 
 

4. Decryption is considered successful if the first 4 bytes of the decrypted data contain the 
ASCII string “TRUE”, and if the CRC-32 checksum of the last 256 bytes of the decrypted 
data (volume header) matches the value located at the 8th byte of the decrypted data (this 
value is unknown to an adversary because it is encrypted – see TrueCrypt Volume Format 
Specification). If these conditions are not met, mounting is terminated (either a wrong 
password, a corrupted volume, or not a TrueCrypt volume). 
 

5. Now we know (or assume, with very high probability) that we have the correct password, 
the correct encryption algorithm, mode, key size, block size, and the correct header key 
derivation algorithm. We also know whether we are mounting a hidden volume or not. The 
minimum program version required to open the volume, stored in the decrypted volume 
header is checked. If it is not equal or less than the version of the program that we are using 
to mount the volume, mounting is terminated. 
 

6. The encryption routine is reinitialised with the master key† and IV retrieved from the 
decrypted volume header. This key can be used to decrypt any sector of the volume, except 
the volume header area (which has been encrypted using the header key). The volume is 
mounted. 

 
See also Modes of Operation, Whitening, and Header Key Derivation, Salt, and Iteration Count. 
 

                                                 
* These parameters are kept secret not in order to increase the complexity of an attack, but primarily to make TrueCrypt volumes 
unidentifiable (undistinguishable from random data), which would be difficult to achieve if these parameters were stored within the 
volume header. 
† The master key was generated during the volume creation and cannot be changed later. Volume password change is accomplished 
by re-encrypting the volume header using a new header key (derived from a new password). 
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Modes of Operation 
 
The following table lists all encryption algorithms implemented in TrueCrypt and the modes in 
which they operate: 
 

Encryption Algorithm Mode of Operation Details of the Mode of Operation 

   

AES* CBC Ci = EK(Pi ^ Ci - 1); C0 is IV. 

AES-Blowfish 
(E2)           (E1) Inner-CBC Cn = E2K2((Sm || Sm+1) ^ Cn - 1); Sm = E1K1(Pm ^ Sm-1); 

C0 and S0 are IVs. 

AES-Blowfish-Serpent 
(E3)        (E2)              (E1) Inner-CBC Cn = E3K3((Sm || Sm+1) ^ Cn - 1); Sm = E2K2(Tm ^ Sm-1); 

Tm || Tm+1 = Qn = E1K1(Pn ^ Qn-1); C0, S0, and Q0 are IVs.† 

AES-Twofish 
(E2)           (E1) Outer-CBC Ci = E2K2(E1K1(Pi ^ Ci - 1)); C0 is IV. 

AES-Twofish-Serpent 
(E3)        (E2)              (E1) Outer-CBC Ci = E3K3(E2K2(E1K1(Pi ^ Ci - 1))); C0 is IV. 

Blowfish CBC Ci = EK(Pi ^ Ci - 1); C0 is IV. 

CAST5 CBC Ci = EK(Pi ^ Ci - 1); C0 is IV. 

Serpent CBC Ci = EK(Pi ^ Ci - 1); C0 is IV. 

Serpent-AES 
  (E2)         (E1) Outer-CBC Ci = E2K2(E1K1(Pi ^ Ci - 1)); C0 is IV. 

Serpent-Twofish-AES 
    (E3)          (E2)         (E1) Outer-CBC Ci = E3K3(E2K2(E1K1(Pi ^ Ci - 1))); C0 is IV. 

Triple DES Outer-CBC Ci = EK3(DK2(EK1(Pi ^ Ci - 1))); C0 is IV. 

Twofish CBC Ci = EK(Pi ^ Ci - 1); C0 is IV. 

Twofish-Serpent 
 (E2)           (E1) Outer-CBC Ci = E2K2(E1K1(Pi ^ Ci - 1)); C0 is IV. 

   
 

                                                 
* In this table, we use the term “AES” to refer to “AES-256”. 
† Tm || Tm+1 = Qn denotes a 128-bit block Qn being split into two 64-bit blocks Tm and Tm+1. 
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IV (initialisation vector) is always a random value (unknown to an adversary), which is unique to 
each sector* and volume. This value is generated as follows: 
 

1. Bytes 256-263 (for a 128-bit block cipher, bytes 256-271) of the decrypted volume header 
are retrieved (see the sections TrueCrypt Volume Format Specification and Encryption 
Scheme). If ciphers in a cascade use more than one IV, the successive bytes are retrieved for 
the additional IVs (for example, for three 128-bit block ciphers in a cascade in inner-CBC 
mode, bytes 256-271 are retrieved for the first IV, bytes 272-287 for the second, and 288-
303 for the third IV). 
 

2. Data retrieved in (1) are XORed with the 64-bit sector number (each sector is 512 bytes 
long; sectors are numbered starting at 0). In case of a 128-bit block cipher, the upper and 
lower 64-bit words of the 128-bit value retrieved in (1) are XORed with an identical value. 
The resultant 64-bit value (or 128-bit for 128-bit block ciphers) is the IV. 
 
i.e., 
For a 128-bit block cipher: 
T1 = upper 64-bit word of the value retrieved in (1) 
T2 = lower 64-bit word of the value retrieved in (1) 
S = sector number   (64-bit integer) 
IV = (T1 ^ S) || (T2 ^ S)  
 
For a 64-bit block cipher: 
T = 64-bit value retrieved in (1) 
S = sector number   (64-bit unsigned integer) 
IV = T ^ S 
 

Note: Step (1) is only performed once, right after the volume is mounted. The retrieved data 
remain in RAM then.  
 

Ciphers in a cascade use mutually independent keys (note that the header keys they use are 
independent as well, even though they are derived from one password – see Header Key Derivation, 
Salt, and Iteration Count). 
 

Whitening 
 
To make obtaining a plaintext/ciphertext pair more difficult [16], the following technique, similar to 
one that is sometimes called whitening, is applied: Every eight bytes of each sector (after the sector 
is encrypted) are XORed with a 64-bit value, which is unique to each sector and volume (and is 
unknown to an adversary). The value is generated as follows: 
 

1. Bytes 264-271 (for a 128-bit block cipher, bytes 272-279) of the decrypted volume header 
are retrieved† (see TrueCrypt Volume Format Specification and Encryption Scheme). 
 

                                                 
* Each sector is 512 bytes long; sectors are numbered starting at 0. 
† All necessary data are retrieved from the volume header right after the volume is mounted, and they remain in RAM until the 
volume is dismounted. 



 

TrueCrypt User’s Guide. Copyright © 2004-2005 TrueCrypt Foundation. All rights reserved. 
 

35 

2. Bytes 272-279 (for a 128-bit block cipher, bytes 280-287) of the decrypted volume header 
are retrieved. 
 

3. Data retrieved in (1) are XORed with the 64-bit sector number (each sector is 512 bytes 
long; sectors are numbered starting at 0). 
 

4. Data retrieved in (2) are XORed with the 64-bit sector number. 
 

5. A 32-bit CRC-32 value of the first 8 bytes of the resultant value in (3) is calculated. 
 

6. A 32-bit CRC-32 value of the second 8 bytes of the resultant value in (3) is calculated. 
 

7. A 32-bit CRC-32 value of the first 8 bytes of the resultant value in (4) is calculated. 
 

8. A 32-bit CRC-32 value of the second 8 bytes of the resultant value in (4) is calculated. 
 

9. The value calculated in (5) is XORed with the value calculated in (8). 
 

10. The value calculated in (6) is XORed with the value calculated in (7). 
 

11. The 32-bit value calculated in (9) is written to the upper 32-bit word and the value 
calculated in (10) is written to the lower 32-bit word of the 64-bit whitening value. 

 
Remark: The steps 5-8 are performed to increase the Hamming distance between individual 
whitening values. 
 
Summary: 
 
T1 = 64-bit value retrieved in (1) 
T2 = 64-bit value retrieved in (2) 
S = sector number   (64-bit unsigned integer) 
T1 = T1 ^ S 
T2 = T2 ^ S 
Q1 = upper 32-bit word of T1 
Q2 = lower 32-bit word of T1 
Q3 = upper 32-bit word of T2 
Q4 = lower 32-bit word of T2 
W = (CRC32(Q1) ^ CRC32(Q4)) || (CRC32(Q2) ^ CRC32(Q3)) 
 
Actual whitening is applied as follows: 
 
For a 128-bit block cipher: 
T1 = upper 64-bit word of C 
T2 = lower 64-bit word of C 
C’ = (T1 ^ W) || (T2 ^ W)  
 
For a 64-bit block cipher: 
C’ = C ^ W 
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Header Key Derivation, Salt, and Iteration Count 
 
Header key is used to decrypt the encrypted area of the TrueCrypt volume header (see the sections 
Encryption Scheme and TrueCrypt Volume Format Specification). The technique that TrueCrypt 
uses to generate header keys is PBKDF2, specified in PKCS #5 v2.0; see [7].  
 
A 512-bit salt (random values generated using the built-in random number generator during the 
volume creation process) is used, which means there are 2512 keys for each password. This 
significantly decreases vulnerability to 'off-line' dictionary attacks (pre-computing all the keys for a 
dictionary of passwords is very difficult when a salt is used) [7]. Two thousand iterations of the key 
derivation function have to be performed to derive a header key, which significantly increases the 
time necessary to perform an exhaustive search for passwords (i.e., brute force attack) [7]. The 
header key derivation function is based on HMAC-SHA-1 or HMAC-RIPEMD-160 (see [8, 9, 20, 
22]) – the user selects which. Neither the quality, nor the length of the derived key is limited by the 
size of the output of the underlying hash function (the derived key has always the required size, i.e., 
not only 160 bits). For more information, refer to [7]. 
 
Header keys used by the ciphers in a cascade are mutually independent, even though they are 
derived from one password. For example, for the AES-Twofish-Serpent cascade, the header key 
derivation function is instructed to derive a 768-bit key from a given password. This key is then 
split into three 256-bit keys, out of which the first key is used by Serpent, the second key is used by 
Twofish, and the third key is used by AES. 

 
Random Number Generator 
 
The random number generator implemented in TrueCrypt is used to generate the master encryption 
key, salt, and the values used to create IV and whitening values (see the section Modes of 
Operation, and Whitening).  
 
The random number generator creates a pool of random values in RAM (memory). The pool, which 
is 256 bytes long, is filled with data from the following sources: 
 

• Mouse movement within the TrueCrypt Volume Creation Wizard window (CRC32-hashed 
mouse coordinates, and event delta/absolute times): 
CRC32(MouseCoordinates) || CRC32(EventDeltaTime || EventTime) 
 

• Mouse clicks within the TrueCrypt Volume Creation Wizard window (CRC32-hashed 
button IDs, and event delta/absolute times): 
CRC32(MouseButtonID) || CRC32(EventDeltaTime || EventTime) 
 

• Keystrokes while the mouse pointer is within the TrueCrypt Volume Creation Wizard 
window (CRC32-hashed key codes and event delta/absolute times): 
CRC32(KeyID) || CRC32(EventDeltaTime || AbsoluteEventTime) 
 

• Performance statistics of disk drives 
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• Network interface statistics (NETAPI32)  
 

• MS Windows CryptoAPI 
 

• Various Win32 handles, time variables, and counters (collected at 250-ms interval) 
 
A mouse or keystroke event is accepted only if it is different from the last and penultimate events 
from the respective source. EventDeltaTime denotes the time difference between the current and last 
accepted event from the source. AbsoluteEventTime denotes the value of the system timer when the 
event is accepted. 
 
Before a value obtained from any of the above-mentioned sources is written to the pool, it is split 
into bytes (e.g., a 32-bit output of CRC-32 is split into four bytes). These bytes are then individually 
written to the pool with the modulo 28 addition operation (not by replacing the old values in the 
pool) at the position of the pool cursor. After a byte is written, the cursor position is advanced by 
one byte. When the cursor reaches the end of the pool, its position is set to the beginning of the 
pool. In addition, after a value (byte) is added to the pool, the pool is entirely hashed using a hash 
function (SHA-1 or RIPEMD-160 – the user selects which). 
 
The design and implementation of the random number generator are based on the following: 
 

• Software Generation of Practically Strong Random Numbers by Peter Gutmann [10] 
 

• Cryptographic Random Numbers by Carl Ellison [11] 
 

 
TrueCrypt Volume Format Specification 
 
TrueCrypt volume has no “signature“. Until decrypted, it appears to consist of random data entirely. 
Therefore, it is impossible to identify a TrueCrypt container or partition. 
 
Free space of each TrueCrypt volume is filled with random data when the volume is created (if 
Quick Format is disabled). The random data is generated as follows: Right before TrueCrypt 
volume formatting begins, a temporary encryption key, plaintext block, IV and whitening seeds, are 
generated by the built-in random number generator (all of these items are stored in RAM and are 
discarded after formatting finishes). The encryption algorithm that the user selected is initialised 
with the temporary key, and the ciphertext blocks it produces are used to fill (overwrite) the free 
space on the volume. IVs are generated as usual (see Modes of Operation) except that the IV seed is 
not retrieved from the volume header but is generated by the random number generator. Whitening 
is also applied as usual (see Whitening) but whitening values are derived from the value generated 
by the random number generator.
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TrueCrypt volume format version 1 specification: 
 

 
Offset  
(bytes) 

 
Size 

(bytes) 

 
Encryption 

Status 

 
 

Description 
 

 
      0 
    64 
    68 
    70 
    72 
    76 
    84 
    92 
  100 
  256 
  288 
  512 

 
    64 
      4 
      2 
      2 
      4 
      8 
      8 
      8 
  156 
    32 
  224 
  N/A 

 
  Not Encrypted 
  Encrypted 
  Encrypted 
  Encrypted 
  Encrypted 
  Encrypted 
  Encrypted 
  Encrypted 
  Encrypted 
  Encrypted 
  Encrypted 
  Encrypted 

 
  Salt* 
  ASCII string “TRUE” 
  Volume header format version 
  Minimum program version required to open the volume 
  CRC-32 checksum of the (decrypted) bytes 256-511 
  Volume creation time 
  Header creation/modification time 
  Reserved (set to zero) 
  Unused 
  Data used to generate IV and whitening values 
  Master encryption key(s)† 
  Data area (actual volume contents) 
 

 
 
If a TrueCrypt volume hosts a hidden volume (within its free space), the header of the hidden 
volume is located at the byte 1536 (offset) from the end of the host volume (the header of the 
host/outer volume is located at the beginning of the volume – see the section Hidden Volume). The 
format of the hidden volume header is specified in the following table: 
 

 
Offset  
(bytes) 

 
Size 

(bytes) 

 
Encryption 

Status 

 
 

Description 
 

 
      0 
    64 
    68 
    70 
    72 
    76 
    84 
    92 
  100 
  256 
  288 
   

 
    64 
      4 
      2 
      2 
      4 
      8 
      8 
      8 
  156 
    32 
  224 
   

 
  Not Encrypted 
  Encrypted 
  Encrypted 
  Encrypted 
  Encrypted 
  Encrypted 
  Encrypted 
  Encrypted 
  Encrypted 
  Encrypted 
  Encrypted 
   

 
  Salt 
  ASCII string “TRUE” 
  Volume header format version 
  Minimum program version required to open the volume 
  CRC-32 checksum of the (decrypted) bytes 256-511 
  Volume creation time 
  Header creation/modification time 
  Size of the hidden volume 
  Unused 
  Data used to generate IV and whitening values 
  Master encryption key(s)‡ 
 

                                                 
* Note that salt does not need to be encrypted, as it does not have to be kept secret [7] (salt is a sequence of random values). 
†There is more than one master key, when the volume is encrypted using a cascade of ciphers. 
‡ There is more than one master key, when the volume is encrypted using a cascade of ciphers. 
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The bytes 0-63 (salt), bytes 256-287 (data used to generate IV and whitening values), and bytes 
288-511 (master encryption key), contain random values that have been generated using the built-in 
random number generator (see the section Random Number Generator) during the volume creation 
process.  
 
 

Compliance with Standards and Specifications 
 
TrueCrypt complies with the following standards, specifications, and recommendations: 
 

• PKCS #5 v2.0  [7] 
• FIPS 46-3  [13] 
• FIPS 197  [3] 
• FIPS 198  [22] 
• FIPS 180-2  [14] 
• NIST S. P. 800-38A  [12] 

 
 

Source Code 
 
The complete source code of TrueCrypt (C and assembly) is available at:  
http://truecrypt.sourceforge.net/downloads.php 
 

 
 
Future Development 
 
For the list of features that are planned for a future release, refer to: 
http://truecrypt.sourceforge.net/future.php 

 
 

Contact 
 
Information on how to contact us can be found at:  
http://truecrypt.sourceforge.net/contact.php 
 

http://truecrypt.sourceforge.net/downloads.php
http://truecrypt.sourceforge.net/future.php
http://truecrypt.sourceforge.net/contact.php
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Version History 
 
3.1a 
 
February 7, 2005  

Bug fixes:  

• Volumes mounted as removable media can now be checked/repaired (‘chkdsk.exe’), defragmented, 
formatted, etc. 

• The Volume Creation Wizard now respects default mount options set via Tools->Preferences. 

• Fixed bug which caused mount/dismount to fail on some systems. 

• The TrueCrypt uninstaller is now always installed during installation. 

• Relative paths can be used with the /volume option (command line usage). 

• Drive A: will no longer disappear from Windows Explorer (e.g., ‘My Computer’ list) after ‘Dismount All’. 

• Other minor bug fixes 

 
Improvements: 

• When running in ‘traveller’ mode, the TrueCrypt driver will be unloaded when no longer needed (e.g., 
when the main application and/or the last instance of the Volume Creation Wizard is closed and no 
TrueCrypt volumes are mounted).  

• Access mode (read-only or read-write) is now displayed in the volume properties dialog. 

• Other minor improvements 

 
3.1 
 
January 22, 2005  

Improvements: 

• Partitions/devices that are already in use by another driver (usually an anti-virus utility) can now be 
mounted. 

• It is now possible to run multiple instances of the TrueCrypt Volume Creation Wizard. 

 
New features: 

• TrueCrypt can now run in 'traveller' mode, which means that it does not have to be installed on the 
operating system under which it is run. There are two ways to run TrueCrypt in 'traveller' mode: 
 
1) After you unpack the binary distribution archive, you can directly run ‘TrueCrypt.exe’. 
 
2) You can use the new ‘Traveller Disk Setup’ facility (accessible from the ‘Tools’ menu) to prepare a 
special 'traveller' disk and launch TrueCrypt from it. This facility can also configure a 'traveller' disk in a 
way that when it is inserted, TrueCrypt is automatically started or a specified volume is mounted (note 
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that this works only when the ‘traveller’ disk is a removable medium such as a CD or DVD; Windows XP 
SP2 is required in case of USB memory sticks). 

• Volumes can now be mounted as read-only. This can be set in the newly implemented ‘Mount Options’ 
dialog, which can be opened from the password entry dialog or by holding Control while clicking 
‘Mount’. (Command line usage: ‘/mountoption ro’) 

• Volumes can now be mounted as removable media (for example to prevent Windows from creating the 
'Recycled' and/or 'System Volume Information' folders on the volume). This can be set in the newly 
implemented ‘Mount Options’ dialog, which can be opened from the password entry dialog or by 
holding Control while clicking ‘Mount’. (Command line usage: ‘/mountoption rm’) 

• Default mount options can be configured in the main program preferences (Tools -> Preferences). 

• ‘Refresh Drive Letters’ function added to the tools menu. It can be used when Windows Explorer fails to 
register a newly mounted volume (for example when it is not shown in the ‘My Computer’ list). 

• Volume can now be selected by dragging its icon to the TrueCrypt program window (this also allows to 
avoid the Windows file selector). 

• '/auto devices' auto-mounts all device/partition-hosted TrueCrypt volumes (command line usage) 

 
Bug fixes: 

• The ‘Auto-Mount Devices’ facility will not mount ‘phantom’ partitions on some removable media (e.g. 
USB memory sticks).  

• In some cases TrueCrypt did not use all available space on some removable media (such as USB 
memory sticks). 
Remark: This bug was inherited from E4M, so it applies also to volumes created by E4M. 
 
Warning: Note that this means it will not be possible to mount hidden volumes (does not apply to file-
hosted containers) created with TrueCrypt 3.0 or 3.0a that are located on some removable media, e.g., 
some USB memory sticks, (because the expected position of a hidden volume changes with the size of 
its host volume). If that is the case, please before upgrading to TrueCrypt 3.1, move your files to a 
temporary TrueCrypt volume on a non-removable medium or to a non-hidden volume on a removable 
medium and move the data from the old hidden volume to this temporary one. Then install TrueCrypt 
3.1, create a new hidden volume and move your files from the temporary volume to it. 

• Freezing caused by applications not responding to drive change messages when mounting/dismounting 
TrueCrypt volumes will no longer occur. 

• Users are now prevented from setting a too small cluster size when creating a FAT volume (which 
caused various problems). 

• The command line parser no longer causes TrueCrypt to crash. 

• Other minor bug fixes 

 
3.0a 
 
December 11, 2004  

Bug fixes: 

• Data corruption will not occur when data is written to a volume encrypted with Twofish or Serpent 
while another TrueCrypt volume is mounted (applies also to volumes encrypted using a cascade of 
ciphers, out of which one is Twofish or Serpent). 
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• Other minor bug fixes 

 
3.0 
 
December 10, 2004  

New features: 

• Ability to create and mount a hidden TrueCrypt volume (file container or partition/device). This allows 
solving situations where the user is forced by an adversary to reveal the password and cannot refuse to 
do so (for example, when the adversary uses violence). 
 
The principle is that a TrueCrypt volume is created within another TrueCrypt volume (within the free 
space on the volume). Even when the outer volume is mounted, it is impossible to tell whether there is 
a hidden volume within it or not, because free space on any TrueCrypt volume is always filled with 
random data when the volume is created and no part of the hidden volume can be distinguished from 
random data. 
 
The password for the hidden volume must be different from the password for the outer volume. To the 
outer volume, (before creating the hidden volume within it) you should copy some sensitive-looking 
files that you do NOT really want to hide. These files will be there for anyone who would force you to 
hand over the password. You will reveal only the password for the outer volume, not for the hidden 
one. Files that are really sensitive will be stored on the hidden volume.  
 
As it is very difficult or even impossible for an inexperienced user to set the size of the hidden volume 
such that the hidden volume does not overwrite any data on the outer volume, the Volume Creation 
Wizard automatically scans the cluster bitmap of the outer volume (before the hidden volume is 
created within it) and determines the maximum possible size of the hidden volume. 

• Serpent encryption algorithm (256-bit key) 

• Twofish encryption algorithm (256-bit key) 

• Forced/“brutal” dismount (allows dismounting a volume containing files being used by the system or an 
application). 

• Cascades of ciphers added (e.g., AES-Twofish-Serpent, AES-Blowfish, etc.) Each of the ciphers in a 
cascade uses its own encryption key (the keys are mutually independent). 

• Ability to mount a TrueCrypt volume that is being used by the system or an application (shared access 
mode).  

• Ability to encrypt devices/partitions that are being used by the system or an application. 

• The ‘Select Device’ dialog and the ‘Auto-Mount Partitions’ facility now support devices that do not 
contain any partitions. 

• Encryption Algorithm Benchmark facility added to the Tools menu and to the Volume Creation Wizard. 

• A warning is displayed if Caps Lock is on when creating a new volume or changing a password. 

• When /l is omitted and /a is used, the first free drive letter is used (command line usage) 

• New command line option: /force or /f enables forced (“brutal”) dismount or mounting in shared mode 
(i.e., without exclusive access). 

• Drive letters are now displayed in the ‘Select Device’ window. 
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Bug fixes: 

• ‘Blue screen’ errors (system crashes) will not occur when dismounting a volume (remark: this bug was 
inherited from E4M). 

• The ‘Select Device’ dialog will display also partitions being used by the system or an application. 

• If the size of a partition/device was not a multiple of 1024 bytes, its last sector (512 bytes) was not 
used for TrueCrypt volume (the volume was 512 bytes shorter than the partition/device). 
Remark: This bug was inherited from E4M, so it applies also to encrypted partitions/devices created by 
E4M. 

• FAT volumes that are exactly 129 MB in size will not have zero size of free space (129-MB FAT volumes 
created by the previous versions had no free space available).  

• Users without administrator privileges can now create file containers under Windows Server 2003. 

• Other minor bug fixes 
 

Improvements: 

• The timestamp of a container (date and time that the container was last accessed, and last modified) 
will not be updated when TrueCrypt accesses the container (i.e., after dismounting, attempting to 
mount, changing or attempting to change the password, or creating a hidden volume within it).  

• The TrueCrypt Service is no longer necessary and has been removed because its functions are now 
handled by the TrueCrypt driver. 

• When ‘Never save history’ is checked, Windows is prevented from saving the file names of the last 
accessed file containers to the ‘Recent Documents’ and File Selector history.  

• Other minor improvements 
 

Miscellaneous: 

• TrueCrypt has been successfully tested on the Windows “Longhorn” operating system (beta version of 
the future successor to Windows XP). 

• The user can now override the minimum password length (a warning is displayed and a confirmation is 
required). 

2.1a 
 
October 1, 2004  

Removed Features: 

• IDEA encryption algorithm removed. This allows non-profit and profit organizations to use TrueCrypt 
without having to obtain a separate license for IDEA (according to the IDEA license, any use of 
software containing the IDEA algorithm by a non-profit or profit organization is considered as use for 
commercial purposes, and is subject to a license from MediaCrypt AG). 
 
Important: TrueCrypt volumes encrypted using the IDEA encryption algorithm cannot be mounted 
using TrueCrypt 2.1a. If you have such a volume, before upgrading to TrueCrypt 2.1a, please create a 
new TrueCrypt volume using a cipher other than IDEA and move your files to this new volume.  
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2.1 
 
June 21, 2004  

New features: 

• RIPEMD-160 hash algorithm added.  The user can now select which hash algorithm TrueCrypt will use 
(SHA-1 or RIPEMD-160).  
 
Note: RIPEMD-160, which was designed by an open academic community, represents a valuable 
alternative to SHA-1 designed by the NSA and NIST. In the previous versions there was a risk that the 
whole program would be practically useless, should a major weakness be found in SHA-1. The user-
selected hash algorithm is used by the random number generator when creating new volumes, and by 
the header key derivation function (HMAC based on a hash function, as specified in PKCS #5 v2.0). The 
random number generator generates the master encryption key, salt, and the values used to create IV 
and ‘whitening’ values. 

• When changing a volume password, the user can now select the HMAC hash algorithm that will be used 
in deriving the new volume header key.  

• It is now possible to create NTFS TrueCrypt volumes and unformatted TrueCrypt volumes. This 
enhancement also removes the 2048 GB volume size limit. (Only FAT volumes can be created using the 
previous versions of TrueCrypt. Any FAT volume, encrypted or not, cannot be over 2048 GB.) 

• Header key content is now displayed in the Volume Creation Wizard window (instead of salt). 

• Random pool, master key, and header key contents can be prevented from being displayed in the 
Volume Creation Wizard window. 
 

Bug fixes: 

• When there is a mounted TrueCrypt container that is stored in another TrueCrypt container, it will be 
possible to dismount both of them using the ‘Dismount All’ function, and ‘blue screen’ errors will not 
occur upon system shutdown. 

• Minor bug fixes to command line handling. 
 

Improvements: 

• Several minor improvements to the driver. 
 

Miscellaneous: 

• Released under the original E4M license to avoid potential problems relating to the GPL license (added 
the IDEA patent information and specific legal notices). 
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2.0 
 
June 7, 2004  

Bug fixes: 

• Data corruption will no longer occur when a TrueCrypt partition is subjected to heavy parallel usage 
(usually when copying files to or from a TrueCrypt partition). This also fixes the problem with 
temporarily inaccessible files stored in TrueCrypt partitions. 

Note: File-hosted volumes were not affected by this bug. 

• After dismounting and remounting a volume, its file system will be correctly recognized by the 
operating system and it will be possible to reuse the same drive letter (Windows 2000 issue). 

• The main program window will not be displayed when run in quiet mode (command line usage).  

• Two password entry attempts are no longer necessary to be able to mount a volume (command line 
usage).  

• All partitions will be visible to TrueCrypt even if one of them is inaccessible to the operating system (an 
inaccessible partition made all successive partitions on the hard disk unavailable to TrueCrypt).  

• Relative path can be specified when mounting a file-hosted volume (command line usage). 

• Incorrect passwords are reported when auto-mounting (command line usage). 
 

New features: 

• AES-256 (Rijndael) encryption algorithm. 

• The command line option /dismountall was renamed to /dismount which can now be also used to 
dismount a single volume by specifying its drive letter. 
 

Improvements: 

• Memory pages containing TrueCrypt volume encryption keys and whitening seeds are now locked to 
prevent them from being swapped to the Windows page file. 

• The state of the random pool will never be exported directly so the pool contents will not be leaked. 
 

Miscellaneous: 

• Released under GNU General Public License (GPL) 
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1.0a (by TrueCrypt Team) 
 
February 3, 2004  

Removed features: 

• TrueCrypt no longer supports Windows 98/ME. 

 
 
1.0 (by TrueCrypt Team) 
 
February 2, 2004  

Note: TrueCrypt is based on E4M (Encryption for the Masses). Therefore, the following list contains 
differences between E4M 2.02a and TrueCrypt 1.0 (minor differences have been omitted). 
 
 
Improvements: 

• Windows XP/2000 support 

• The maximum volume size is 18,446,744,073 GB (E4M only allows 2 GB).  
Note: File system, hardware connection standard, and operating system limitations have to be taken 
into account when determining maximum volume size. 

• Plausible deniability. It is impossible to identify a TrueCrypt container or partition. Until decrypted, a 
TrueCrypt volume appears to consist of nothing more than random data (it does not contain any 
"signature"). Therefore, it is impossible to prove that a file, a partition or a device is a TrueCrypt 
volume and/or that it has been encrypted. To achieve plausible deniability, the format of the volume 
and the encryption process had to be significantly changed. 

• The salt is 64 bytes long now (E4M uses 20 bytes). 

• The iteration count of the key derivation function increased to 2,000 (E4M uses 1,000). 

• Free space is filled with random data during volume creation, instead of filling it with zeroes. This 
reduces the amount of predictable plaintext and, in future, will increase the level of plausible deniability 
of hidden volumes. 

• Up to 32 partitions per physical disk drive can be encrypted now (Windows XP/2000). 

• The minimum volume password length has been increased to 12 characters. 

• The maximum volume password length has been decreased from 100 to 64 characters. This was 
necessary to avoid the following: When a password longer than 64 characters was passed to HMAC-
SHA-1, the whole password was first hashed using SHA-1 and the resultant 160-bit value was then 
used instead of the original password (which complies with HMAC-SHA-1 specification), thus the 
password length was in fact reduced. 

• The Blowfish key length size has been increased to 448 bits. 
Remark: Even though our increasing the key size to 448 bits might appear to be a significant overkill, 
there was no reason for us not to do so (note that there is no decrease in speed of 
encryption/decryption). 
 

Bug fixes: 

• Sector scrambling algorithm flaw fixed. Two or more disk sectors to be encrypted consisting of the 
same values (e.g. filled with zeroes), after being encrypted by E4M, start with the same 8-byte 
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sequence of values (i.e. the first eight bytes of any of these encrypted sectors contain the same values 
as the first eight bytes of any other of these encrypted sectors). If this had not been fixed, the 
plausible deniability would not have been possible.  

• TrueCrypt volumes can be dismounted (Windows XP issue). 

• "Blue screen" errors no longer occur during Windows shutdown when there is one or more mounted 
TrueCrypt volumes. 

• Drive geometry is calculated correctly now (chkdsk.exe and format.exe do not fail anymore). 

• A TrueCrypt volume can be reformatted as FAT32 or NTFS using the Windows built-in format tool 
(Windows XP/2000 issue). 

• Windows Check Disk can now be used on TrueCrypt volumes (Windows XP/2000 issue). 

• Windows Disk Defragmenter can now be used on encrypted volumes (Windows XP/2000 issue). 
 

New features: 

• New IV (initialization vector) generation algorithm (see the documentation for more information) 

• Every 8 bytes of each sector (after the sector is encrypted) are XORed with a random 64-bit value, 
which is unique to each sector and volume (sector is 512 bytes long). This makes obtaining a 
plaintext/ciphertext pair a bit more difficult. 

• New function to clear the volume history. 

• When selecting a partition/device, the sizes and file system types of available partitions/devices are 
displayed (Windows XP/2000). 

• List of mounted TrueCrypt volumes now contains their sizes and encryption algorithms used (Windows 
XP/2000). 

• Free volume space is reported (in 'My Computer' list etc.) 

• Windows XP format facilities do not support formatting volumes larger than 32 GB as FAT32. However, 
with TrueCrypt Volume Creation Wizard it is now possible to create FAT32 volumes larger than 32 GB. 

• New function that allows multiple TrueCrypt partitions to be mounted provided that their correct 
password(s) has/have been entered (this includes the cached passwords, if there are any). 

• Quick format (partitions/devices only) 

• Cluster size selection (when creating new volumes) 

• Volume properties can now be examined (encryption algorithm, volume creation time, last password 
change time etc.) 

• New function to dismount all mounted TrueCrypt volumes. 

• New command line options to dismount all mounted TrueCrypt volumes: /d and /dismountall 

• HMAC-SHA1 and CRC-32 algorithm tests are now included in the self-test facility. 

• Program menu and Preferences window added. 
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• Custom user interface fonts supported. 

• Optionally, the TrueCrypt installer can now create System Restore points (Windows XP/ME). 

• Password input field is wiped after a correct volume password has been entered. 

• New graphics, icons, user interface 

• New documentation 
 

Removed features: 

• E4M and SFS volumes are no longer supported. 

• DES cipher removed. 

• HMAC-MD5 removed (to be replaced by HMAC-RIPEMD-160). 
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